Chapter 471

Confidence Intervals for the Difference Between Two Means

Introduction

This procedure calculates the sample size necessary to achieve a specified distance from the difference in sample means to the confidence limit(s) at a stated confidence level for a confidence interval about the difference in means when the underlying data distribution is normal.

Caution: This procedure assumes that the standard deviations of the future samples will be the same as the standard deviations that are specified. If the standard deviation to be used in the procedure is estimated from a previous sample or represents the population standard deviation, the Confidence Intervals for the Difference between Two Means with Tolerance Probability procedure should be considered. That procedure controls the probability that the distance from the difference in means to the confidence limits will be less than or equal to the value specified.

Technical Details

There are two formulas for calculating a confidence interval for the difference between two population means. The different formulas are based on whether the standard deviations are assumed to be equal or unequal.

For each of the cases below, let the means of the two populations be represented by \( \mu_1 \) and \( \mu_2 \), and let the standard deviations of the two populations be represented as \( \sigma_1 \) and \( \sigma_2 \).

Case 1 – Standard Deviations Assumed Equal

When \( \sigma_1 = \sigma_2 = \sigma \) are unknown, the appropriate two-sided confidence interval for \( \mu_1 - \mu_2 \) is

\[
\bar{X}_1 - \bar{X}_2 \pm t_{1-\alpha/2, n_1+n_2-2} s_p \sqrt{\frac{1}{n_1} + \frac{1}{n_2}}
\]

where

\[
s_p = \sqrt{\frac{(n_1 - 1)s_1^2 + (n_2 - 1)s_2^2}{n_1 + n_2 - 2}}
\]

Upper and lower one-sided confidence intervals can be obtained by replacing \( \alpha/2 \) with \( \alpha \).
Confidence Intervals for the Difference Between Two Means

The required sample size for a given precision, D, can be found by solving the following equation iteratively

\[ D = t_{1-\alpha/2,\nu} \sqrt{\frac{1}{n_1} + \frac{1}{n_2}} \]

This equation can be used to solve for D or \( n_1 \) or \( n_2 \) based on the values of the remaining parameters.

Case 2 – Standard Deviations Assumed Unequal

When \( \sigma_1 \neq \sigma_2 \) are unknown, the appropriate two-sided confidence interval for \( \mu_1 - \mu_2 \) is

\[ \bar{X}_1 - \bar{X}_2 \pm t_{1-\alpha/2,\nu} \sqrt{\frac{s_1^2}{n_1} + \frac{s_2^2}{n_2}} \]

where

\[ \nu = \frac{\left( \frac{s_1^2}{n_1} + \frac{s_2^2}{n_2} \right)^2}{\frac{s_1^4}{n_1^2(n_1 - 1)} + \frac{s_2^4}{n_2^2(n_2 - 1)}} \]

In this case t is an approximate t and the method is known as the Welch-Satterthwaite method. Upper and lower one-sided confidence intervals can be obtained by replacing \( \alpha/2 \) with \( \alpha \).

The required sample size for a given precision, D, can be found by solving the following equation iteratively

\[ D = t_{1-\alpha/2,\nu} \sqrt{\frac{s_1^2}{n_1} + \frac{s_2^2}{n_2}} \]

This equation can be used to solve for D or \( n_1 \) or \( n_2 \) based on the values of the remaining parameters.

Confidence Level

The confidence level, \( 1 - \alpha \), has the following interpretation. If thousands of samples of \( n_1 \) and \( n_2 \) items are drawn from populations using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population mean difference is \( 1 - \alpha \).

Notice that is a long term statement about many, many samples.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters.

One-Sided or Two-Sided Interval

Interval Type

Specify whether the interval to be used will be a one-sided or a two-sided confidence interval.

Confidence

Confidence Level (1 – \( \alpha \))

The confidence level, \( 1 – \alpha \), has the following interpretation. If thousands of samples of \( n_1 \) and \( n_2 \) items are drawn from populations using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population mean difference is \( 1 – \alpha \).

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90, 0.95 or 0.90 to 0.99 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation

Select the option that describes the constraints on \( N_1 \) or \( N_2 \) or both.

The options are

- Equal (\( N_1 = N_2 \))
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- Enter \( N_1 \), solve for \( N_2 \)
  Select this option when you wish to fix \( N_1 \) at some value (or values), and then solve only for \( N_2 \). Please note that for some values of \( N_1 \), there may not be a value of \( N_2 \) that is large enough to obtain the desired power.

- Enter \( N_2 \), solve for \( N_1 \)
  Select this option when you wish to fix \( N_2 \) at some value (or values), and then solve only for \( N_1 \). Please note that for some values of \( N_2 \), there may not be a value of \( N_1 \) that is large enough to obtain the desired power.

- Enter \( R = N_2/N_1 \), solve for \( N_1 \) and \( N_2 \)
  For this choice, you set a value for the ratio of \( N_2 \) to \( N_1 \), and then PASS determines the needed \( N_1 \) and \( N_2 \), with this ratio, to obtain the desired power. An equivalent representation of the ratio, \( R \), is
Confidence Intervals for the Difference Between Two Means

\[ N_2 = R \times N_1. \]

- **Enter percentage in Group 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed \( N_1 \) and \( N_2 \) with this percentage to obtain the desired power.

**N1 (Sample Size, Group 1)**

*This option is displayed if Group Allocation = “Enter N1, solve for N2”*

\( N_1 \) is the number of items or individuals sampled from the Group 1 population.

\( N_1 \) must be \( \geq 2 \). You can enter a single value or a series of values.

**N2 (Sample Size, Group 2)**

*This option is displayed if Group Allocation = “Enter N2, solve for N1”*

\( N_2 \) is the number of items or individuals sampled from the Group 2 population.

\( N_2 \) must be \( \geq 2 \). You can enter a single value or a series of values.

**R (Group Sample Size Ratio)**

*This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”*

\( R \) is the ratio of \( N_2 \) to \( N_1 \). That is,

\[ R = \frac{N_2}{N_1}. \]

Use this value to fix the ratio of \( N_2 \) to \( N_1 \) while solving for \( N_1 \) and \( N_2 \). Only sample size combinations with this ratio are considered.

\( N_2 \) is related to \( N_1 \) by the formula:

\[ N_2 = \lceil R \times N_1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N_1 = 10 \) and \( N_2 = 20 \), or \( N_1 = 50 \) and \( N_2 = 100 \)).

\( R \) must be greater than 0. If \( R < 1 \), then \( N_2 \) will be less than \( N_1 \); if \( R > 1 \), then \( N_2 \) will be greater than \( N_1 \). You can enter a single or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”*

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for \( N_1 \) and \( N_2 \). Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.
Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.

N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.

N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:

\[ N2 = \left\lfloor R \times N1 \right\rfloor, \]

where the value \([Y]\) is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.
Confidence Intervals for the Difference Between Two Means

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”*

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

**Precision**

**Distance from Mean Difference to Limit(s)**

This is the distance from the confidence limit(s) to the difference in means. For two-sided intervals, it is also known as the precision, half-width, or margin of error.

You can enter a single value or a list of values. The value(s) must be greater than zero.

**Standard Deviations**

**S1 and S2 (Standard Deviations)**

Enter an estimate of the standard deviation of group 1 or 2. The standard deviation must be a positive number.

Caution: The sample size estimates for this procedure assume that the standard deviation that is achieved when the confidence interval is produced is the same as the standard deviation entered here.

Press the 'Standard Deviation Estimator' button to obtain help on estimating the standard deviation.

You can enter a range of values such as 1, 2, 3 or 1 to 10 by 1.

**Standard Deviation Equality Assumption**

Specify whether the standard deviations are assumed to be the same or different. The choice will determine which of the two common confidence interval formulas for estimating the difference in population means will be used.

- **Assume S1 and S2 are Unequal**
  
  When the standard deviations are assumed to be unequal, the variances are not pooled and an approximate method is used for the confidence interval formula. This approximate method is sometimes called the Welch-Satterthwaite method.

- **Assume S1 and S2 are Equal**
  
  When the standard deviations are assumed to be equal, the pooled variance formula is used in the calculation of the confidence interval. The degrees of freedom are N1 + N2 – 2.

  Recommendation: Because the standard deviations of two populations are rarely equal, it is recommended that the standard deviations are assumed to be unequal. The Welch-Satterthwaite confidence interval calculation is generally accepted and commonly used.
Example 1 – Calculating Sample Size

Suppose a study is planned in which the researcher wishes to construct a two-sided 95% confidence interval for the difference between two population means such that the width of the interval is no wider than 20 units. The confidence level is set at 0.95, but 0.99 is included for comparative purposes. The standard deviation estimates, based on the range of data values, are 32 for Population 1 and 38 for Population 2. Instead of examining only the interval half-width of 10, a series of half-widths from 5 to 15 will also be considered.

The goal is to determine the necessary sample size for each group.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for the Difference Between Two Means procedure window by expanding Means, then Two Independent Means, then clicking on Confidence Interval, and then clicking on Confidence Intervals for the Difference Between Two Means. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level</td>
<td>0.95 0.99</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Distance from Mean Diff to Limit(s)</td>
<td>5 to 15 by 1</td>
</tr>
<tr>
<td>S1 (Standard Deviation Group 1)</td>
<td>32</td>
</tr>
<tr>
<td>S2 (Standard Deviation Group 2)</td>
<td>38</td>
</tr>
<tr>
<td>Std. Dev. Equality Assumption</td>
<td>Assume S1 and S2 are Unequal</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Confidence Level</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Target Dist from Mean Diff to Limits</th>
<th>Actual Dist from Mean Diff to Limits</th>
<th>S1</th>
<th>S2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.950</td>
<td>380</td>
<td>380</td>
<td>760</td>
<td>5.000</td>
<td>4.995</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>265</td>
<td>265</td>
<td>530</td>
<td>6.000</td>
<td>5.995</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>195</td>
<td>195</td>
<td>390</td>
<td>7.000</td>
<td>6.995</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>150</td>
<td>150</td>
<td>300</td>
<td>8.000</td>
<td>7.984</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>119</td>
<td>119</td>
<td>238</td>
<td>9.000</td>
<td>8.973</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>97</td>
<td>97</td>
<td>194</td>
<td>10.000</td>
<td>9.951</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>80</td>
<td>80</td>
<td>160</td>
<td>11.000</td>
<td>10.973</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>68</td>
<td>68</td>
<td>136</td>
<td>12.000</td>
<td>11.918</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>58</td>
<td>58</td>
<td>116</td>
<td>13.000</td>
<td>12.926</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>50</td>
<td>50</td>
<td>100</td>
<td>14.000</td>
<td>13.947</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.950</td>
<td>44</td>
<td>44</td>
<td>88</td>
<td>15.000</td>
<td>14.895</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.990</td>
<td>655</td>
<td>655</td>
<td>1310</td>
<td>6.000</td>
<td>5.999</td>
<td>32.00</td>
<td>38.00</td>
</tr>
<tr>
<td>0.990</td>
<td>455</td>
<td>455</td>
<td>910</td>
<td>6.000</td>
<td>5.999</td>
<td>32.00</td>
<td>38.00</td>
</tr>
</tbody>
</table>

(report continues)
References

Report Definitions
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, sample size, etc.) that would contain the true difference in population means.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
Target Dist from Mean Diff to Limit is the value of the distance that is entered into the procedure.
Actual Dist from Mean Diff to Limit is the value of the distance that is obtained from the procedure.
S1 and S2 are the standard deviations upon which the distance from mean difference to limit calculations are based.

Summary Statements
Group sample sizes of 380 and 380 produce a two-sided 95% confidence interval with a distance from the difference in means to the limits that is equal to 4.995 when the estimated standard deviations are 32.00 and 38.00.

This report shows the calculated sample size for each of the scenarios.

Plots Section

These plots show the sample size of each group versus the precision for the two confidence levels.
Example 2 – Validation using Ostle and Malone

Ostle and Malone (1988) page 150 give an example of a precision calculation for a confidence interval for the difference between two means when the confidence level is 95%, the two standard deviations are 6.2185 and 16.06767, and the sample sizes are 7 and 6. The precision is 13.433 (when df = 6.257, not 6).

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for the Difference Between Two Means procedure window by expanding Means, then Two Independent Means, then clicking on Confidence Interval, and then clicking on Confidence Intervals for the Difference Between Two Means. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level</td>
<td>0.90</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Enter N2, solve for N1</td>
</tr>
<tr>
<td>N2</td>
<td>6</td>
</tr>
<tr>
<td>Distance from Mean Diff to Limit(s)</td>
<td>13.433</td>
</tr>
<tr>
<td>S1 (Standard Deviation Group 1)</td>
<td>6.2185</td>
</tr>
<tr>
<td>S2 (Standard Deviation Group 2)</td>
<td>16.06767</td>
</tr>
<tr>
<td>Std. Dev. Equality Assumption</td>
<td>Assume S1 and S2 are Unequal</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Confidence Level</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Target Dist from Mean Diff to Limits</th>
<th>Actual Dist from Mean Diff to Limits</th>
<th>S1</th>
<th>S2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.900</td>
<td>7</td>
<td>6</td>
<td>13</td>
<td>13.433</td>
<td>13.433</td>
<td>6.22</td>
<td>16.07</td>
</tr>
</tbody>
</table>

PASS also calculated the sample size in Group 1 to be 7.
Example 3 – Validation using Zar

Zar (1984) page 132 gives an example of a precision calculation for a confidence interval for the difference between two means when the confidence level is 95%, the pooled standard deviation estimate is 0.7206, and the sample sizes are 6 and 7. The precision is 0.88.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for the Difference Between Two Means procedure window by expanding Means, then Two Independent Means, then clicking on Confidence Interval, and then clicking on Confidence Intervals for the Difference Between Two Means. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Distance from Mean Difference to Limit</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level</td>
<td>0.95</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Enter N1 and N2 individually</td>
</tr>
<tr>
<td>N1 (Sample Size Group 1)</td>
<td>6</td>
</tr>
<tr>
<td>N2 (Sample Size Group 2)</td>
<td>7</td>
</tr>
<tr>
<td>S1 (Standard Deviation Group 1)</td>
<td>0.7206</td>
</tr>
<tr>
<td>S2 (Standard Deviation Group 2)</td>
<td>S1</td>
</tr>
<tr>
<td>Std. Dev. Equality Assumption</td>
<td>Assume S1 and S2 are Equal</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Confidence Level</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Dist from Mean Diff to Limits</th>
<th>S1</th>
<th>S2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.950</td>
<td>6</td>
<td>7</td>
<td>13</td>
<td>0.882</td>
<td>0.72</td>
<td>0.72</td>
</tr>
</tbody>
</table>

PASS also calculates the precision to be 0.88.